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1. System configuration 

The system configuration of TOP and “Instrument Inc. – Temperature Controller SR Series” is as follows: 

 

Series CPU Link I/F 
Communication 

method 
System setting Cable 

SR Mini 

HG 

(H-PCP-J) 

H-PCP-J-□4□-D*□ 
Connector 

on the controller 

RS–422 

(4 wire) 

3. TOP 

communication 

setting 

4. External device 

setting 

5.1. Cable table 1 

H-PCP-J-□5□-D*□ 
Connector 

on the controller 

RS–485 

(2 wire) 

H-PCP-J-□1-D*□ 
Connector 

on the controller 
RS–232C 

H-PCP-J-□4-D*□ 
Connector 

on the controller 

RS–422 

(4 wire) 

H-PCP-J-□5-D*□ 
Connector 

on the controller 

RS–485 

(2 wire) 

SRZ 

(Z–TIO) 

Z-TIO-A□-□/□-□ 

Z-TIO-B□-□/□N□-□ 

Z-TIO-C□-□/□-□ 

Z-TIO-D□-□/□N□-□ 

Terminal Block  

on the controller 

RS–485 

(2 wire) 

5.2. Cable table 2 
SRZ 

(Z–DIO) 

Z-DIO-A□-□/□-□ 

Z-DIO-A□-□N 

Terminal Block  

on the controller 

RS–485 

(2 wire) 

SRZ 

(Z–CT) 

Z-CT-A□/□-□ 

Z-CT-A□/N 

Terminal Block  

on the controller 

RS–485 

(2 wire) 

SRZ 

(Z–COM) 

Z-COM-A-4□/□ 

Z-COM-A-4□/N 

COM.PORT 1/2 

on the controller 

RS–422 

(4 wire) 

5.1. Cable table 1 

Z-COM-A-5□/□ 

Z-COM-A-5□/N 

COM.PORT 1/2 

on the controller 

RS–485 

(2 wire) 

Z-COM-A-□4/□ 

Z-COM-A-□4/N 

COM.PORT 3/4 

on the controller 

RS–422 

(4 wire) 

Z-COM-A-□5/□ 

Z-COM-A-□5/N 

COM.PORT 3/4 

on the controller 

RS–485 

(2 wire) 

 

■ Connectable configuration 

 

ㆍ1:1 connection – – RS-232C/ 422 / 485 communication 

 

 

 

 

 

 1 : N connection– RS-422 / 485 communication 

 

. . . 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the display and process of TOP to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “RKC Instrument Inc.” 

PLC Select an external device to connect to TOP. 
 

Model Interface Protocol 

SR Series Serial Private Protocol 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [ Project > Project Property > TOP Setting ] → [ HMI Setup > “Use HMI Setup” Check > Edit > Serial ] 

– Set the TOP communication interface in TOP Design Studio. 
 

 
 

 
 

Items TOP External device Remarks 

Signal Level (port) RS-232C / RS-422 / RS-485 RS-232C / RS-422 / RS-485  

Baud Rate 19200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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(2) Communication option setting 

■ [ Project > Project Property > Device Settings > COM > “PLC1: SR Series” ] 

– Set the options of the SR Series communication driver in TOP Design Studio. 

 

 

Items Settings Remarks 

Interface Configure the communication interface between the TOP and an external device. Refer to “2. External 

device selection”. Protocol Configure the communication protocol between the TOP and an external device. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Retry Configure the amount of redelivery attempts from TOP to external device.  

Station Num Enter the prefix of an external device.  

Type Select model type. SR-Mini, SRZ 
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3.2. Communication setting in TOP  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [ Main Screen > Control Panel > Serial ] 
 

 

Items TOP External device Remarks 

Signal Level (port) RS-232C / RS-422 / RS-485 RS-232C / RS-422 / RS-485  

Baud Rate 19200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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(2) Communication option setting 

■ [ Main Screen > Control Panel > PLC ]  
 

  

 

Items Settings Remarks 

Interface Configure the communication interface between the TOP and an external device. Refer to “2. External 

device selection”. Protocol Configure the communication protocol between the TOP and an external device. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Retry Configure the amount of redelivery attempts from TOP to external device.  

Station Num Enter the prefix of an external device.  

Type Select model type. SR-Mini, SRZ 
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [Control Panel > PLC ]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. TOP communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 
 

For more detailed setting methods than described in this example, please refer to the PLC user manual. 

■ For H-PCP-J-□4□-D*□, H-PCP-J-□4-D*□ 

ㆍFront Rotary Switch Setting: Prefix 

ㆍDip Switch Setting 

SW2 Value Description 

1 OFF Data bit configuration 

Data Bit: 8 / Stop Bit: 1 / Parity None 2 OFF 

3 ON 
Communication speed: 19200 bps 

4 OFF 

5 OFF 

Communication protocol: RKC PROTOCOL 
6 OFF 

7 OFF 

8 OFF 

 

 

■ Z-TIO-A□-□/□-□, Z-TIO-B□-□/□N□-□, Z-TIO-C□-□/□-□, Z-TIO-D□-□/□N□-□ 

For Z-DIO-A□-□/□-□, Z-DIO-A□-□N, Z-CT-A□/□-□, Z-CT-A□/N 

ㆍFront Rotary Switch Setting: Prefix 

ㆍDip Switch Setting 

SW Value Explanation 

1 OFF 
Communication speed: 19200 bps 

2 ON 

3 OFF 
Data bit configuration 

Data Bit: 8 / Stop Bit: 1 / Parity None 
4 OFF 

5 ON 

6 OFF Communication protocol: RKC PROTOCOL 

7 OFF ━ 

8 OFF ━ 

 

 

■ ForZ-COM-A-4□/□, Z-COM-A-4□/N, Z-COM-A-□4/□, Z-COM-A-□4/N 

ㆍFront Rotary Switch Setting: Prefix 

ㆍDip Switch Setting 

PORT SW Value Description 

COM. PORT1 & 

COM. PORT2 

1 OFF 
Communication speed: 19200 bps 

2 ON 

3 ON 
MODBUS 

Data Bit: 8 / Stop Bit: 1 / Parity None 

COM. PORT3 & 

COM. PORT4 

4 ON Communication speed: 19200 bps 

5 OFF 
RKC PROTOCOL 

Data Bit: 8 / Stop Bit: 1 / Parity None 
6 OFF 

7 OFF 

 8 OFF ━ 
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5. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagram described in this section may differ from the recommendations of “RKC Instrument Inc.”) 

5.1 Cable Table 1  
 

■ RS-232C (1:1 connection) 

TOP 

 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

     

 

Based on 

communication 

cable connector 

front, 

6 pin male RJ12  

RD 2 2 SD 

SD 3 3 SG 

  4 RD 

SG 5   

  6 SG 

    

    

 
  

 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 (1:1 connection) 

TOP 

 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  1 R(A) 

 

Based on 

communication 

cable connector 

front, 

6 pin male RJ12  

  2 R(B) 

  3 SG 

RDB 4 4 T(B) 

SG 5 5 T(A) 

SDA 6 6 SG 

    

    

SDB 
9  

 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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■ RS-422  (1:N connection) 

ㆍFor SR Mini HG (H-PCP-A-□4N-□*□Z-1021) / SR Mini HG(H-PCP-J-□4□-D*□)  

TOP 

 

COM.PORT1 COM.PORT2 

 

External device 

Signal name 
Pin 

number 

Signal 

name 

Pin 

number 

Signal 

name 

Pin 

number 

Signal 

name 

RDA 

 

4 T(B) 4 T(B)  4 T(B) 

RDB 5 T(A) 5 T(A) 5 T(A) 

SDA 2 R(B) 2 R(B) 2 R(B) 

SDB 1 R(A) 1 R(A) 1 R(A) 

SG 3 SG 3 SG 3 SG 

  6 SG 6 SG  6 SG 

 

ㆍ Remaining devices 

TOP 

 

External device 

 

External device 

Signal name 
Pin 

number 

Signal 

name 

Pin 

number 

Signal 

name 

RDA  4 T(B)  4 T(B) 

RDB 5 T(A) 5 T(A) 

SDA 2 R(B) 2 R(B) 

SDB 1 R(A) 1 R(A) 

SG 3 SG 3 SG 

  6 SG  6 SG 
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■ RS-485 1:1 connection 
 

TOP 

 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  1 T/R(A) 

 

Based on 

communication 

cable connector 

front, 

6 pin male RJ12  

  2 T/R(B) 

  3 SG 

RDB 4   

SG 5   

SDA 6   

    

    

SDB 
9  

 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
 

TOP 

 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 15 Pin male 

(male, convex) 

 1  1 T/R(A) 

 

Based on 

communication 

cable connector 

front, 

6 pin male RJ12  

(Omitted) 2 T/R(B) 

3 SG 

 10   

RDA 11   

RDB 12   

SDA 13   

SDB 14   

SG 15   

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-485  1:N connection 
 

ㆍFor SR Mini HG(H-PCP-J-□5□-D*□)  

TOP 

 

COM.PORT1 COM.PORT2 

 

External device 

Signal name 
Pin 

number 

Signal 

name 

Pin 

number 

Signal 

name 

Pin 

number 

Signal 

name 

RDA  1 T/R(A) 1 T/R(A)  1 T/R(A) 

RDB 2 T/R(B) 2 T/R(B) 2 T/R(B) 

SDA 3 SG 3 SG 3 SG 

SDB       

SG       

         

 

ㆍRemaining devices  

TOP 

 

External device 

 

External device 

Signal name 
Pin 

number 

Signal 

name 

Pin 

number 

Signal 

name 

RDA  1 T/R(A)  1 T/R(A) 

RDB 2 T/R(B) 2 T/R(B) 

SDA 3 SG 3 SG 

SDB     

SG     
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5.2. Cable table 2 
 

■ RS-485 1:1 connection 
 

TOP 

 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
Pin arrangement 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  T/R(B) 

Terminal Block 

on the Controller 

  T/R(A) 

  SG 

RDB 4  

SG 5  

SDA 6  

  

  

SDB 9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
 

 

■ RS-485  1:N connection 

 

TOP 
 

External device 
 

External device 

Signal name Signal name Signal name 

RDA  T/R(B)  T/R(B) 

RDB T/R(A) T/R(A) 

SDA SG SG 

SDB   

SG   
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6. Supported addresses 

The devices available in TOP are as follows:  

SR Series, for [devices][Command Index][channel] forms, has an existing address version, and has a new address version for forms 

[Commands] / [Channel]. 

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use. 
 

※ Depending on the model, the number of decimal places in the FLOAT type may vary. Please refer to the table and set up the 

external device. (Write Only) 

Existing version New version 
Bit address 

Word 
address 

Double word 
address 

R/W 
Data type 

(Decimal places) Device 
Command 

Index 
Device 

(Commands) 

WDEV 00 M1 M1/01.00 ~ M1/99.31 ━ M1/01 ~ M1/99 R FLOAT 

01 O1 O1/01.00 ~ O1/99.31 ━ O1/01 ~ O1/99 R FLOAT 

02 O2 O2/01.00 ~ O2/99.31 ━ O2/01 ~ O2/99 R FLOAT 

03 M3 M3/01.00 ~ M3/99.31 ━ M3/01 ~ M3/99 R FLOAT 

04 M4 M4/01.00 ~ M4/99.31 ━ M4/01 ~ M4/99 R FLOAT 

05 MS MS/01.00 ~MS/99.31 ━ MS/01 ~ MS/99 R FLOAT 

06 S1 S1/01.00 ~ S1/99.31 ━ S1/01 ~ S1/99 R/W FLOAT (1) 

07 P1 P1/01.00 ~ P1/99.31 ━ P1/01 ~ P1/99 R/W FLOAT (1) 

08 P2 P2/01.00 ~ P2/99.31 ━ P2/01 ~ P2/99 R/W FLOAT (1) 

09 I1 I1/01.00 ~ I1/99.31 ━ I1/01 ~ I1/99 R/W  

10 D1 D1/01.00 ~ D1/99.31 ━ D1/01 ~ D1/99 R/W  

11 V1 V1/01.00 ~ V1/99.31 ━ V1/01 ~ V1/99 R/W FLOAT (1) 

12 A1 A1/01.00 ~ A1/99.31 ━ A1/01 ~ A1/99 R/W FLOAT (1) 

13 A2 A2/01.00 ~ A2/99.31 ━ A2/01 ~ A2/99 R/W FLOAT (1) 

14 A3 A3/01.00 ~ A3/99.31 ━ A3/01 ~ A3/99 R/W FLOAT (1) 

15 A4 A4/01.00 ~ A4/99.31 ━ A4/01 ~ A4/99 R/W FLOAT (1) 

16 T0 T0/01.00 ~ T0/99.31 ━ T0/01 ~ T0/99 R/W *Note 1) 

17 T1 T1/01.00 ~ T1/99.31 ━ T1/01 ~ T1/99 R/W  

18 PB PB/01.00 ~ PB/99.31 ━ PB/01 ~ PB/99 R/W FLOAT (2) 

19 ON ON/01.00 ~ ON/99.31 ━ ON/01 ~ ON/99 R/W FLOAT (1) 

20 HD HD/01.00 ~ HD/99.31 ━ HD/01 ~ HD/99 R/W FLOAT (1) 

21 T3 T3/01.00 ~ T3/99.31 ━ T3/01 ~ T3/99 R/W  

22 M5 M5/01.00 ~ M5/99.31 ━ M5/01 ~ M5/99 R FLOAT 

23 A5 A5/01.00 ~ A5/99.31 ━ A5/01 ~ A5/99 R/W FLOAT (1) 

24 A6 A6/01.00 ~ A6/99.31 ━ A6/01 ~ A6/99 R/W FLOAT (1) 

25 C6 C6/01.00 ~ C6/99.31 ━ C6/01 ~ C6/99 R/W  

26 V2 V2/01.00 ~ V2/99.31 ━ V2/01 ~ V2/99 R/W FLOAT (1) 

27 M6 M6/01.00 ~ M6/99.31 ━ M6/01 ~ M6/99 R FLOAT 

28 S6 S6/01.00 ~ S6/99.31 ━ S6/01 ~ S6/99 R/W FLOAT (1) 

29 XO XO/01.00 ~ XO/99.31 ━ XO/01 ~ XO/99 R/W  

30 OY OY/01.00 ~ OY/99.31 ━ OY/01 ~ OY/99 R/W  

31 CV CV/01.00 ~ CV/99.31 ━ CV/01 ~ CV/99 R/W FLOAT (1) 

32 CW CW/01.00 ~ CW/99.31 ━ CW/01 ~ CW/99 R/W FLOAT (1) 

33 JK JK/01.00 ~ JK/99.31 ━ JK/01 ~ JK/99 R/W FLOAT (2) 

34 JL JL/01.00 ~ JL/99.31 ━ JL/01 ~ JL/99 R/W FLOAT (2) 

35 L1 L1/01.00 ~ L1/99.31 ━ L1/01 ~ L1/99 R  

36 Q3 Q3/01.00 ~ Q3/99.31 ━ Q3/01 ~ Q3/99 R  

37 Q4 Q4/01.00 ~ Q4/99.31 ━ Q4/01 ~ Q4/99 R/W  

38 A7 A7/01.00 ~ A7/99.31 ━ A7/01 ~ A7/99 R/W FLOAT (1) 

39 KH KH/01.00 ~ KH/99.31 ━ KH/01 ~ KH/99 R/W *Note 2) 

40 KG KG/01.00 ~ KG/99.31 ━ KG/01 ~ KG/99 R/W *Note 2) 
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Existing version New version 

Bit address Word address 
Double word 

address 
R/W 

Data type 
(Decimal places) Device 

Command 
Index 

Device 
(Commands) 

WDEV 41 KI KI/01.00 ~ KI/99.31 ━ KI/01 ~ KI/99 R/W FLOAT (2) 

42 M7 
M7/01.00 ~ 

M7/99.31 
━ M7/01 ~ M7/99 R FLOAT 

43 A8 A8/01.00 ~ A8/99.31 ━ A8/01 ~ A8/99 R/W FLOAT (1) 

44 A9 A9/01.00 ~ A9/99.31 ━ A9/01 ~ A9/99 R/W FLOAT (1) 

45 PC PC/01.00 ~ PC/99.31 ━ PC/01 ~ PC/99 R/W FLOAT (2) 

46 L3 L3/01.00 ~ L3/99.31 ━ L3/01 ~ L3/99 R/W FLOAT (1) 

47 L4 L4/01.00 ~ L4/99.31 ━ L4/01 ~ L4/99 R  

48 L5 L5/01.00 ~ L5/99.31 ━ L5/01 ~ L5/99 R  

49 Q5 Q5/01.00 ~ Q5/99.31 ━ Q5/01 ~ Q5/99 R/W  

50 AJ AJ/01.00 ~ AJ/99.31 ━ AJ/01 ~ AJ/99 R  

51 M8 
M8/01.00 ~ 

M8/99.31 
━ M8/01 ~ M8/99 R FLOAT 

52 V3 V3/01.00 ~ V3/99.31 ━ V3/01 ~ V3/99 R/W FLOAT (1) 

53 TJ TJ/01.00 ~ TJ/99.31 ━ TJ/01 ~ TJ/99 R/W  

54 OS OS/01.00 ~ OS/99.31 ━ OS/01 ~ OS/99 R/W FLOAT (1) 

55 OO 
OO/01.00 ~ 

OO/99.31 
━ OO/01 ~ OO/99 R/W FLOAT (1) 

BDEV 00 AA AA/01.00 ~ AA/99.15 AA/01 ~ AA/99 ━ R  

01 AB AB/01.00 ~ AB/99.15 AB/01 ~ AB/99 ━ R  

02 B1 B1/01.00 ~ B1/99.15 B1/01 ~ B1/99 ━ R  

03 AC AC/01.00 ~ AC/99.15 AC/01 ~ AC/99 ━ R  

04 HE HE.00 ~ HE.15 HE ━ R  

05 ER ER.00 ~ ER.15 ER ━ R  

06 G1 G1/01.00 ~ G1/99.15 G1/01 ~ G1/99 ━ R/W  

07 CA CA/01.00 ~ CA/99.15 CA/01 ~ CA/99 ━ R/W  

08 EI EI/01.00 ~ EI/99.15 EI/01 ~ EI/99 ━ R/W  

09 SR SR.00 ~ SR.15 SR ━ R/W  

10 IN IN.00 ~ IN.15 IN ━ R/W  

11 ZA ZA/01.00 ~ ZA/99.15 ZA/01 ~ ZA/99 ━ R/W  

12 J1 J1/01.00 ~ J1/99.15 J1/01 ~ J1/99 ━ R/W  

13 HS HS/01.00 ~ HS/99.15 HS/01 ~ HS/99 ━ R/W  

14 AD AD/01.00 ~ AD/99.15 AD/01 ~ AD/99 ━ R  

15 AE AE/01.00 ~ AE/99.15 AE/01 ~ AE/99 ━ R  

16 JI JI/01.00 ~ JI/99.15 JI/01 ~ JI/99 ━ R/W  

17 JJ JJ/01.00 ~ JJ/99.15 JJ/01 ~ JJ/99 ━ R/W  

18 NJ NJ/01.00 ~ NJ/99.15 ━ NJ/01 ~ NJ/99 R/W *Note 1) 

19 AP AP/01.00 ~ AP/99.15 AP/01 ~ AP/99 ━ R  

20 HP HP/01.00 ~ HP/99.15 HP/01 ~ HP/99 ━ R/W  

21 C2 C2/01.00 ~ C2/99.15 C2/01 ~ C2/99 ━ R/W FLOAT (1) 

22 KF KF/01.00 ~ KF/99.15 ━ KF/01 ~ KF/99 R/W *Note 1) 

23 AF AF/01.00 ~ AF/99.15 AF/01 ~ AF/99 ━ R  

24 AG AG/01.00 ~ AG/99.15 AG/01 ~ AG/99 ━ R  

25 B2 B2/01.00 ~ B2/99.15 B2/01 ~ B2/99 ━ R  

26 EJ EJ/01.00 ~ EJ/99.15 EJ/01 ~ EJ/99 ━ R/W  

27 AH AH/01.00 ~ AH/99.15 AH/01 ~ AH/99 ━ R  

28 C1 C1/01.00 ~ C1/99.15 C1/01 ~ C1/99 ━ R/W  

WFUN 00 AR AR/01.00 ~ AR/99.15 AR/01 ~ AR/99 ━ R/W  

Device example) BDEV0001.00 = AA/01.00  
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*Note 1) Data type differs depending on model.  

Address SR-Mini SRZ 

T0 DEC FLOAT (1) 

NJ DEC FLOAT (1) 

KF DEC FLOAT (2) 

 

*Note 2) Decimal place differs depending on model. 

Address SR-Mini SRZ 

KH FLOAT (1) FLOAT (2) 

KG FLOAT (3) FLOAT (2) 

 


